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> Download GGI

e JAVA s required in your computer. You need to download
the Imagine (PDF based) version at:
https://tb.plazi.org/GgServer/Downloads/Gglmagine-Def
ault.imagine.zip

e Then you need to unzip it directly where you want to
have the software installed. For example, the root folder
of the C: or D: drives

e After that you need to update the software by opening it
once, because the version on the website is not the latest

version

— A \4



https://tb.plazi.org/GgServer/Downloads/GgImagine-Default.imagine.zip
https://tb.plazi.org/GgServer/Downloads/GgImagine-Default.imagine.zip
http://plazi.org/treatmentbank/desktop-data-mining/

> Installing and opening GGI

e After that you need to update the software by opening it
once, because the version on the website is not the latest
version.

Open “Gglmagine” application and allow its acces to the
web

| £ Gamta 12/14/2022 4:25 AM Executable Jar File 1,785 KB

| % GamtalmagingAPI 7/27/2021 3:29 AM Executable Jar File 174 KB

[%] Gglmagine 2/4/2020 5:58 AM Windows Batch File 1 KB Allow Web Access? X
| Gglmagine.cnfg 4/13/2023 5:31 PM 50 KB
| Gglmagine.cnfg.2023-04-13-17-31-10.0ld 4/13/2023 5:31 PM 50 KB 9 Allow GoldenGATE Imagine and its components to access the web?
_| Gglmagine.contextMenu.cnfg 2/4/2020 NFG File 1 KB

B Gglmagine 2/4/2020 5:58 AM pplication 78 KB No

%] Gglmagine 3/27/2023 € ble Jar File 662 KB t
| Gglmagine.menus.cnfg S y ! le 4KB
| Gglmagine.pdfDecoderCharset.cnfg 2/4/2020 5:58 AM | 1 KB

[%] Gglmagine 2/4/2020 5:58 AM Shell Script
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> Installing and opening GGl ..o o

- update 'GgUpdate.IM. 20210405-1524.zip' is available locally.
- update 'Ggpdate.IM.20161109-1142.zip' is out of date.
- update 'GgUpdate.IM.20190912-1344.zip' is out of date.

e DO NOT (ever) click on any skip

’

e "Yes” to download new versions and select “Move Along’
always when asked. Do not choose “Ignore All Together”

Download new Version of Configuration? X

There is a more recent version of the selected Configuration available at https://th.plazi.org/GgServer/Configurations/.
Should GoldenGATE download the new version?

How to Handle Cached Data? X
No
How to handle cached content in local configuration?
AuthorityAugmenterData | GbifData Move Along v
TreeFATData | GbifData Move Along v
TreeFATData [ IpniData Move Along v
Plugins | DocumentStyleProviderData ' Ignore Altogether v . DON'T
Plugins | ImsDocumentIOData Move Along v

Remember my Choices?




> Installing and opening GGl

o Select “Default.imagine” with the Plazi server option

Bl select Configuration — O X
Please select the configuration to load.
Config Name Config Host Last Modified
Local Master Configuration Local 2023.04.14.10.52
{IDefault.imagine Local 2023.04.12.18.07
Slim.bast.imagine Local 2023.02.15.18.55
Slim.mat.imagine Local 2023.02.15.19.32
Slim. tax.imagine Local 2023.02.15.19.34
Slim. treat.imagine Local 2023.02.15.19.33
{Default.imagine https: //tb.plazi.org/GgServer/Confi... :2023.04.12.19.07
Online.imagine https: //tb.plazi.org/GgServer/Confi... [2016.03.07.15.40
ServerBatch.imagine https://tb.plazi.org/GgServer/Confi... [2023.02.15.17.56
Slim.bast.imagine https: //tb.plazi.org/GgServer/Confi... [2023.04.12.13.08
Slim.mat.imagine https://tb.plazi.org/GgServer/Confi... [2023.04.12.15.08
Slim. tax.imagine https: //tb.plazi.org/GgServer/Confi... |2023.04.12.13.08
Slim. treat.imagine https: //tb.plazi.org/GgServer/Confi... [2023.04.12.15.08

OK Cancel Make Master l Configure I




> Installing and opening GGl

o Select “Default.imagine” with the Plazi server option

Bl select Configuration — O X
Please select the configuration to load.
Config Name Config Host Last Modified
Local Master Configuration Local 2023.04.14.10.52
{IDefault.imagine Local 2023.04.12.18.07
Slim.bast.imagine Local 2023.02.15.18.55
Slim.mat.imagine Local 2023.02.15.19.32
Slim. tax.imagine Local 2023.02.15.19.34
Slim. treat.imagine Local 2023.02.15.19.33
{Default.imagine https: //tb.plazi.org/GgServer/Confi... :2023.04.12.19.07
Online.imagine https: //tb.plazi.org/GgServer/Confi... [2016.03.07.15.40
ServerBatch.imagine https://tb.plazi.org/GgServer/Confi... [2023.02.15.17.56
Slim.bast.imagine https: //tb.plazi.org/GgServer/Confi... [2023.04.12.13.08
Slim.mat.imagine https://tb.plazi.org/GgServer/Confi... [2023.04.12.15.08
Slim. tax.imagine https: //tb.plazi.org/GgServer/Confi... |2023.04.12.13.08
Slim. treat.imagine https: //tb.plazi.org/GgServer/Confi... [2023.04.12.15.08

OK Cancel Make Master l Configure I




> Installing and opening GGI

e You should get to this screen

Bl GoldenGATE Imagine - Default.imagine - [m] X

File Export Edit Undo Tools Hel Page 0 of 0 100% v |Pages Top-Down
r p




> Log in to GGI

e The first action is to log in GGl

Click on “File” -> “Load Document from GoldenGATE
Server”

Choose the Plazi account and click “OK"

Fill your username and password (provided to you by
Plazi team)

After logged in, you can cancel the “Open Document
Directly” box that appears, asking a Document ID




> Log in to GGI

Select Account X E
L
@ Please select the account to use for connection.
I 1
. GoldenGATE Imagine - Default.imagine
File Export Edit Undc Tools Help
Open Document
Load Document from URL
Save Document
Save Document As
Save Document to GoldenGATE Server : .
. Log in to https://tb.plazi.org/GgServer/proxy X
Close Document Please enter your login data for the GoldeGATE Server at https: //tb.plazi.org/GgServer fproxy
Exit User Name jonas Password [sesessl
[[] Remember User Name [] change Password
Select Pages :
ok [ cenel




> Opening a document

e To open document from local device, click on “File” ->
“Open Document”

Choose between opening a PDF (born-digital or scanned)
or an IMF file

’ Load Document from URL
e’ imf Load Document from GoldenGATE Server
- Save Documen t

. GoldenGATE Imagine - Default.imagine
File Export Edit Undo Tools Help

Save Document As

g - Save Document to GoldenGATE Server P D F
Close Document
Exit

Select Pages



http://plazi.org/data-apis-tools/image-markup-file/

> Opening a document

. Open

Recent ihems

Desktop

Documents

"

Network

Lookin: |

Learning

D 1981-Article Text-8679-1-10-20221122.pdf.imf
[] Candollea.76.1.1 17-123.pdf.imf

Options for Font Decoding
Decode Unmapped Glyphs
Default Charset
Options for Scanned PDFs

Use Embedded OCR

Adjust to Blocks

Enhance Scans

Expect Meta Pages
Scanned Page Format

Auto-detect

Single Pages

Double Pages

Fix DPI

Help

File name: ‘

Files of type: | Image Markup Files

Image Markup Files

Image Markup Directories
Batch Cached Documents
IPDF Documents
PDF Documents (born-digital)

IPDF Documents (scanned, with or without OCR)
IPDF Documents (scanned, text layer digitized)
IPDF Documents (scanned, text layer vectorized)

.

General PDF Loading Modes

Because PDF documents vary widely in the nature of their content, GoldenGATE Imagine has different modes for decoding them:

® PDF documents: Generic mode, lets the PDF decoder determine which of the four more specific modes (below) to use,
based upon an overall assessment of the PDF. Use this only if you are uncertain about the nature of the PDF at hand.

@ PDF documents (born-digital): For born-digital PDFs, generated from text written in text processors or layout software.
All bitmap images are considered illustrations.

® PDF documents (scanned, with or without OCR): For PDFs that bundle scans of the individual pages of a paper-based
document. Any OCR embedded within the PDF can be used, and the exact positioning of the individual words can be
adjusted to fit the text in the underlying scans as closely as possible.

e PDF d d, text layer digitized): For scanned PDFs in whose scans the text layer has been compietely
replaced (as opposed to supplemented) with OCR output, basically producing a PDF whose text renders like in a
born-digital one, but onto the backdrop of scanned page backgrounds. In particular, there is no actual scanned text anymore
to anchor the OCR to.

® PDF documents (scanned, text layer vectorized): For scanned PDFs in whose scans the text layer has been replaced
with PDF vector graphics, with the latter bundled into special PDF fonts, i.e. DjVu compression.

Options for Font Decoding

Rendered text in born-digital PDFs is mostly represented in the form of strings with 8 bits per character, so representing Unicode
characters outside the ANSI range requires a custom arrangement of the characters in the fonts embedded in the PDF. To accurately
map such custom encoder characters to their corresponding Unicode points, fonts embedded in PDFs provide a Unicode mapping

data structure, intended to facilitate accessibility features like Braille output or text-to-voice, and also to support accurate copy&paste.

However, this data structure is not always present, and sometimes incomplete. On top of that, since most PDF viewers use any
given Unicode mapping as the basis for copy&paste operations , an intentionally erroneous (often chaotic) Unicode mapping can also
be abused to effectively foil copy&paste operations by reducing their result to complete garble.

To overcome these latter obstacles (if present), the PDF decoder has various modes of approaching embedded fonts. In general, if
the Unicode mappings in a given PDF are known to be good and accurate, a more trusting approach is perfectly fine, and also
requires less computational effort. On the other hand, the more computationally intensive approaches can overcome a much wider
range of shortcomings and obfuscation techniques. The particular font decoding modes are:

® Do Not Decode Fonts: Takes any given Unicode mapping at face value, supplemented with the raw 8-bit values from the
PDF strings, not even rendering the glyphs. This mode cannot determine font style (bold, italics) or the type of a given font
(serif vs. sans-serif vs. monospaced) beyond hints from the font name. This mode is mostly good for basic PDF to text
conversion.

@ Render Glyphs Only: Takes any given Unicode

at face value, )! d with the raw 8-bit values from the

v
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> Scanned documents

e Depending on the quality of the scan, the OCR will be
better or worst

e Remember to select ‘PDF Documents (scanned)’ when
you open the file in GGI

e Move the ‘weight of OCR’ bar (close to the ‘word’ box in
the Display Control) to the right to be able to fix OCR




> Scanned documents R

O word A

| Percentage weight of OCR text on top of page imagel
1 I

croisement de la ligne médiane avec le bord antérieur de Paire frontale externe.
Les quatre taches triangulaires du mésonotum sont équivalentes et I'on retrouve
qualrre macules rondes égalementi trés semblables entre elles en avanl de I'éléva-
tion cruciforme, Dessous du thorax couleur noisette, de méme que les pattes,
Opercules jointifs, le rostre dépassant de pew le point de jonction postérieur,
Abdomen bistre, l1égérement plus clair sur les cyvmbacalvptes. Maculature apicale
des homélvtres plus délice que chez T giovanninge ;| coloris moins constrastés
sur Paire apicale des ailes postéricures dont une teinte brique occupe principas
lement I'aire basale.

Imensions  Longueur du corps = 32 mm ; envergure — 98 munm ; largeur de
la| Dimensions Longiueur du corps = 32 mm , envergure = 98 mm ; largeur de
1 [JBold []1talics [Symbols
Dimensions Longueur du corps = 32 mm ; envergure = 98 mm ; largeur de
mcts vicihlae da nenfil [Mrite X narticulibdvement roahnceis mate nradnicant dec Inhec \\x;/A




> Opening a document

e To open IMF file from Plazi server, using UUID found in
the TreatmentBank publication page

Click on “File” -> “Load Document from GoldenGATE
Server”

You need to log in GGl if you still did not do it



http://plazi.org/data-apis-tools/image-markup-file/

> Opening a document

Bl GoldenGATE Imagine - Default.imagine
File Export Edit Undo Tools Help

Open Document
Load Document from URL
Load Document from GoldenGATE Server

Save Document
Save Document As

Save Document to GoldenGATE Server

Close Document
Exit

Select Pages

tb.plazi.org/GgServer/summary,

D51BB22BFF9BFFOCF12F8517FE69AE2F

Select Account X

@ Please select the account to use for connection.
= hittps:/[b:plazi.org/GaServerfproxy: 443 (via HTTE) V

uuiD

- Log in to https://tb.plazi.crg/GgServer/proxy
Please enter your login data for the GoldeGATE Server at https://tb.plazi.org/GgServer fproxy

User Name  fionas Password [eesess|
[[] Remember User Name [[] Change Password
[ oK l Cancel ||
T f T
T s st L

. Open Document Directly

Enter document ID to load a specific document directly, or proceed to document list.

Document ID: | D5 18B228FF9BFFOCF 12F85 17FEGOAEZF

Showlist || [ Load | | Cancel || | FetchMode ||

F

C i




> Annotations in GGI

e As we use the tools for individual extraction, new
annotations are added to our “Display Control” (at the
right side of your view)

ol | Annotations [ [eesasmtd]
° In order to Work Ol D'SDax;v:: & Show All Hide Al o spedmenCount

With them, they Regions, Blocks, etc. | accessDate m subSection
need tobeticked | s o D0 e DL

. S— O bibRef ] superScript

. = H bibRefCitation [0 [ __tebleCitation |

] = (] | bookContentinfo | [] | taxonomicName |

LIl it | ] caption J i taxonomicNameLabel ]

m | region | [0 | _collectingCountry | 0] title

O | table 7| [] | collectngDate | 1] treatment

0 tableCell [ | collectingMunicipality m typeStatus

O | tableCol | 0O collectingRegion m volumeTitle

[ foeon ] collectionCode Ol year ‘v




> After loading document

'Kalanchoe darainensis (Crassulaceae),
a new species from northeastern
Madagascar

David-Paul Klein. Ronen Shtein, Louis Nusbaumer & Martin W. Callmande ‘

KLLINS D% R SHILING L NUSBAUMER & MW CALLMANDLR 2021 Kalalchos durailetsis Crasuli
Lortheaster} Madaguscus Candodie 76 117127 1 Llzlisk& Liglish ald Urelch abstracts DOT hupalxduiorgi1U.1535

i-Lew soecies rom
U213 761l 2

A lew species bl smalld rosulate-al'd upright-Ilowered Kalanchoe Adals (Crassulucead) {rom Lortheaster]
is described ald illustrated Kalanchoe darainensis 13 Kleill & Callmy Morphologically& Kalanchoe darainensis
sumilar ta Kelanchoe blossfeldiana Poclll ald Kelarichoe globulitera Hi Perrier which are kKfow [ Hroni the Torthwesterl
Tsaratalala Massili © 100 ko southwest ol Daraila Detailed Totes bl the habiat ald ecology ol Kalanchoe darainen:
are providedd as well s 4 short Laxolomical bverview ol wlied species bl the Kalaichoe subg Kalanchoe [ron Madagascas
ilcludilg al ideltilicatol hey ta those species Despile its restricted distributiol il the protected Allsahabe massité the
Tew spcc‘ s i prelimilary assessed as MLeast colcer!” [LC) usilg the [IUCN Red List Criteria

KLLINE DR RSHILING T NUSBAUMER & MW CALLMANDLR 20211 Kidalehoe daruiletsis
Ford-est 1o Madagasear o ais et Frafeais DO hipdd< dainesdl 015553,

ue ule Touvelle espéce
202761413

Ul louvelle espece de Kalanchoe Adals (Crassidaceac ¥ petitede rosulée et i {leurs Uressées du Tord-est de M
estuéerite et illusuée Kalanchoe darainensis 1P Kleil et Cally i [t Kalunchoe darainensis 2st plus|
proche de Kalanchoe bloss feldiana Poellll et Kalunchoe globulifera Hi Perrier qui solt colTues du Tord-ouest du massil
Tsaratalalu& © 100 km au sud-ouestde Daraila; Des Toles détaillées sur Phabital 2t Iécologic de Kalanchoe darainen:
solt-Tourliesd ailsi-gu’ul-brel apercu laxol omique des espiees allices de Kalanchoe subg Kalanchoe de Madagascarde v
vompris ul'e ¢lé dideltlicatiol de ces espéces, Malgré sa distributioll restreil e tal’s Id massil protéed d'Altsahabek
la Touvelle espéee est préalablemelt Evaluée comme wPréoccupatiol mileures [LC el utilisalt les critéres de la Liste

Rouge e I'U

CRASSULACEAL — Kalanchoe -~ Madagascar - Daraifa - Tokv-Mafambato = New species

[Addresses i he huthory

DPK: Humboldt-Ufiversitir zv Barlik Spathstras

& Berlif D21 Gernals E-mail david-paulklein @agrar hu-berlin d(
v Yol I

N MWC Cof: afiaues dc Gofeest oh 2 bt ]
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‘—ﬁa - A new species of Kalanchoe (Cra ifrom

Candollez 76, 2021 |

Display Control

| Introduction

The sefus Kalanchoe Adafs (Crassulaceaci Kalanchooideac |
comprises more thaf  15C species kfowf Lo datc afd occurs
if Madagascar& Africaf Arabia did lmmml Curreftly

2  Madagas-
carc all but ofe of which are efdemic (o the Great Islafd
MADAGASCAR ['\T 0{' IIF’x "0711 The Lefu~ of k'nlmxrhnr

s kf()\\'f from Madagascar® Africaf
afd Asisde as well as Kalanchoe subg Bryophylluni |S:
afd Kalanchoe sube Kirchingia |Baker! Gideof I
eirede& both efdemic lo Madagascar ISMITH &
FIGUEIREDO| 2018
| Kalanchoe subg Kalanchoe ifcludes species that share the
followifg characters plafts affual vr pereffial& herhaceous or
woody-arhoresceft& calyx uffused For most of its lefgth with
ashort Lo ifdistifet bed sepal seamefis oftef freek usually
adpressed Lu the corolla tbe& filamefts ifserted = ahove the
middle bf the corolla uhef rarely helowi flowers typically
rarely omfi-directiofal or pefdefi& leaves af d ifflorescefces
Fever hulbiliferous& carpels cofvergeft& nsuallv much lofger
thaf the stvles& scales elofgated L lifear& with a lefgth/width
ratio usually > & afthers ifcluded if corolla-tuhe or very.
slightly exserted& oftef dressed with u £ spherical coffective
glafd of the afthers (BOTTEAU & ALLORGE-BOITEAU 1995
DESCOINGS& 2003 SMITH & FIGUEIREDOS 201 &)

Amofg the Malagasy represeftatives of Kalanchoe subg
Kalanchoe several morphologically similar species were his-
torically placed if “Group | 3 of RAYMOND-HAMET 111907 Ly
s emphasize the morphologic rities they share with'
species ifdigefous Lo maiflafd Africa& if coftrasttu similari-
ties shared with other species from Madagascar These species
are K. boisii Raym-Hamet & H Perrier, K. briquedi Raym -
Hamet& K. chapotori Ravm-Hamet& K. elobulifera H Perrier
afd K elobulifera var coccinea H -Perrier (= Kl blossfeldiano
Poellfii Later& BOITEAU & ALTORGE-BOITEAL {1995 afd
ALLORGE-BOITEAU [1996] proposed Lo Further subdivide
these species ifto the lwa ifformal eroups "Occideftales" af d
“Globuliferae’ & alofe with Kl wromatica H Perrier K. bouveri
RaymHamet & H Perrier afd K. lanceolata [Forsski] Pers
The group “Globuliferae” was defifed hased of the spherical
coffective glafds “'elobules™: of the afthers& whereas species
placed if “Occideftales” have termifal ifflorescefces& are
alafdular pilose fexcept K. hlossfeldianay afd de fot have the
aforemeftiofed coffective alafds However& they added that
the latter group "fe présefte pas beaucoun d'homogeféie”
da fot preseft much homogefeity [BOITEAU & ALLORGE-
BOITEAUK 1995 187 They alsc ufderlifed the morphologi
affifity of both groups to some coftifeftal Africaf speciesi as
opposed 1o other Malagasy represeftatives of Kalanchoe subg
Kalanchoe: such-as the species they placed if the ifformal
“Lafigerae” groun’

simil

( Fig = Distribution map ot Kaianchoc darainonsis D Kiein  Calim

IoDmsucmMm:anc HOAT 8 SMIT- 2007

Lxcludile Kalanchoe aromaticé al d K. bowvetii thathave,
omlidirectiolal & zygomorphic owers ald distifct corolld
lubesic we colsider Lhe species bl both ilTormal groups& “Occi-
deltales” al'd "Globulilerac & to Torn  commol’ specic:
These are small statured shrubs 1o mediun sized hert
at least partially zovered with & glaldular ifdumel s,
have et actifomorphic Howers& highly reduced te ildistil
calyx lubese Lol deltoid ta Tarrowly lalceolate sepalsd apically
acute 1o acumilate ald lilcar to liliform Tectary scales Tw
Lurther receldy described species& K wntenni fera 1 Desc ald K
pareikiong 1Jesc & Layralos tal also be placed il this spe

d ol their morphology! Kalanchoe intenniferd origi

ity was ulkfow( 1o DESCOINGS 12004}
1 1he protologue Moreover& despils
Arabiad virtually across coltileltal Alricad al'd il
Madagascark Lhe 2xact Latural geographical distributiol ralge
ol K lanceolatd remail's opel 1o coljecture Kalanchoe lanceolata
rather shares character expressiols with species ol Kalanchoe
subg Kalunchoe Iromi bevold Madagascar al'd-accordilgly we
{refrail front placilg ivil this vtherwise Malagasy eroup |

[ Durile ifveltories ol the Darai [ ifow ullud
dambatod see PHILLIPSON et [«
s of smallde rosulateds elaldular pil
were collected il the massil vl Allsahabe |
specimel’s have the erect flowensd lifed liform fectary
scalesé-apically ilserted Tilamells al'd reduced calyx lube that
are Foul'd il represeftatives ol Kalanchoe subg Kalanchoe atd
were ull origifally determifed as represeltile K pumila Baker
However& K. pumila difl ers from the llected specimels by
beife taller 120-30G cmi afd floury-pruifose& by lackife af]
ifdumelum& afd by havil largel pifk-coloured& campalulate

corolla lubes (BAKER 1884 BOITEAU & ALLORGE-BOITEAU&)
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> After detecting document structure

Kalanchoe darainensis (Crassulaceae),
a new species from northeastern
Madagascar

David-Paul Klein; Ronen Shtein, Louis Nusbaumer & Martin W, Callmander

Abstract

KLLING D-P& R SHTLING L NUSBAUMER & MW CALLMANDLR 21
Tortheasterd Madugascus £ o BT 23 LR

& i Few species from
U262

218 Kalalchow daruiletsis Crasuluc
isEd L glinhi a0 Urelchatbstracts' DOV hup?alydoi gl 1,155,

A-Tew! species bl smalld rosulate al'd upright-Iowered Kalanchoe Adals iCrassiduceai Troui Tortheaster] Madagascar
is described ald illustrated Kalunchoe darainensis 107 Kleil & Callmy Mor aicallyle Kale g inensis is Most
similar ta Kelanchoe blossfeldigna Poellll ald K we globulifera HE Perrier which are kKfow!H rony the Torthwester]
Tsaratalala Massitk € 100 Ky southwest ol Daraila’ Detailed Totes ol Lhe habitat ald ecology ol Kalanchoe darainensis
i as well s & short laxolomical bverview ol allied species ol the Kalarchoe subg: Kalanchoe [rom Madagascark
ilcludilg al ideltlicatol ey ta those species Despile its restricted distributiol il the protected Allsahabe massifd the
few species is prelimilary ‘Leastcoleer!™|[LC usilg the IUCN Red List Criteria

Résumeé

KLLINS D#FR R SHTEING T NUSBAUMER & MW CALLMANDLR (21
Ford-est e Madagascas Fedleon TGS Fr afglist iésumds

% il fouvelle Espice dy
0IWTGIEI

Kalalchue Garail efsis
DO ey 3

Ulc Touvelle espece de Kalanchod Adals {Crassiduceae & petilefé rosulée et i
estdécrite et llustrée Kalonchoc daraimensis 139 Kleil et Callmy, Morphol

urs dressées Ju-Tord-estide Madagascar
[ Kalanchoe inensis 2st plus.

proche de Kalunchoe bloss feldiana Poellll et Kalunchoe globidifera Hi Perrier qui solt colTues du ford-ouest du massil d¢
Tsaratalala& ¢ 100 ki au sud-ouest de Daraila; Des [otes détaillées sur Thabitat 2t Técologie de Kalanchoe darainensis

especes alliced de Kalanchoe subg Kalanchoe 3¢ Madagascarde y
distributiol restreiltd daf's I¢-massil protéed d"Altsahabed
Id Liste

soltTourlies& ailsi guul bref aperu laxol omigue de:
compris ule ¢Ié Tideltilicatiol de ces espéces: Malgré
la Louvelle espéee est préalablemelt évaluée comme wPréoccupatiol mileurcs |LC ef utilisaltles
Rouge de 'TUCN]

Keywords

CRASSULACEAL = Kalanchoe = Madagascar = Daraifa = Loky-Mafambato = New species

| sson oo { g wrws f

lintroduction]

The gefus Kalanchod Adafsl [Crassdaceads Kalanchooidead
comprises more thaf 150 species kfowf (u date afd becurs
i afd tropical Asia Curreftly

cr® all but-ofe bf which are efdemic o the Great Tslafd
MADAGASCAR CATALOGUEL 2021/ The gefus of Kalanclioc

afd Asisk s well as Kalanchoc subg Bryophyllum [Salishii
Koorders afd Kalanchoe subg Kirchingia iBaker] Gideof I
Sm & Figueiredo& both efdemic 1o Mad: ar {SMITH &
FIGUEIREDO! 2018}

Kalanchoe subg Kolanchoe ifcludes species that share the
followifg characters plafts affual 1 pereffial§ herbaceous ot
woody-arhoresceft& x uffused For mostof its lefgth with
a-short Lo ifdistifet bed sepal segmefts oftef frezk usually
adpressed Lu the corolla ube& filamefts ifserted £ nhove the
middle bf the coroll rarely belowi& Flowers typically er
rarely-pmfi-directiofal or-pefdef & Jeave { efces
Fever hulhiliferousi carpels cofvergefté usually much lofger

choé-aromatice al'd Kl bowvetii thathave
Lygomorphic Howers afd distifet coroll
the Spec i

16 [orm # comumol spe

thaf the styles& scales elofgated tu lifeark with a lef g
ratio-usually 2 7t afthers ifcluded if corolla-tube or very
Slightly exsertedi oftef dressed with i £ spherical coffective
glafd of the afthers (ROTTEAU & ALLORGE-BOITEAU& 1995
DESCOINGS& 20031 SMITH & FIGUFIREDO: 201 &)

Amofg the Malagasy represeftatives of Kalaichod subg
Kalanchoe several morphologically Similar species were his-
torically placed if “Group 13" bf RAYMOND-HAMET {11907} Lo
s¢-emphasize the morphological similarities they: share with
species ifdigefous Lo maiflafd Africa& if coftrast w similari-
ties shared with nther species From Madagascar! These Species
e K boisii Raymi Hamet & H Perrier, Kl briquerii Raym’
Hamet& K chapotons Raym-Hamet& K. plobulifera H Perrier
afd Kl globulifera var tocanee Hi-Perrier (= Kl blossfeldiana
Poellfii Later& BOITEAU & ATLORGE-BOITEAU {1995 afd
ALLORGE-BOITEAU (1996} proposed-lo-Further subdivide
these species ifto the lwu ifformal groups “Occideftales” afd
“Globuliferae” & alofg with K. wromatica H Perier& Kl bouveris
Raym-Hamet & H Perrier afd anceolata [Forsski} P
The group “Globuliferae’ was defifed hased of the spheri
coffective glafds “globules™; of the afthers& whereas species
placed if "Occideftales™ have termifal ifflorescefcesd are
plafdular pilose fexcept K. blossfeldianai afd de fot-have the
aforemeftiofed coffective glafds However they added that
the latter group "fe présefte pas beaucoup d'homogéféité”
‘da fot preseft much-homogefeity’ (BOITEAU & ALLORGE-
BOITEAU 19951870 They alsc ufderlifed the morphological
affifity of both groups Lo some coftifeftal Africaf speciesi
opposed Lo other Malagasy represeftatives of Kalanchoe subhg
Kalanchoe such-as the species they placed if the ifformal
“Lafigera

are small statured shrubs ta mediun sized

i duced to ildistilet
iy besié lolge deltoid to Larrowly lalceolate sepals apically
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v D & K wntennif
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‘aroupt based oI theit morphology! Kelanchoe antenniferd o
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was ulkfow( ta DESCOINGS 12004}
il the protologue Morcoverk despile its
virtually across coltileltal Alricac al'd il
raphical distributiol ral'ze
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ol Kalanchoe
subg Kulunchoe I'rom beyold Madagascar al'd accordilgly we
relraill froni placils it ill this btherwise M; sroup
Durilg tories bl-the D regiol ifow called
falambatod see PHILLIPSON 2t 214 2018 & Four speci
smallé rosulateds glaldular pilosel succulelt plalts
ted il the massil ol Altsahabe {Fig 1) The:
s have the erect flow [ {
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oceurrelce ilMAr:
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Howeverk K. pumila
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> After adding document metadata

|Kalanchoe darainensis (Crassulaceae),
a new species from northeastern
Madagascar|

David-Paul Klein/Ronen Shtein.Louis Nusbaumer&Martin W, Callmander

Annotations
Show Alll || Hide All

J caption

Display Control docAuthor

Abstract word docID-DOI
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> Images or graphics

B cdit Attributes X
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> Tables

glandular. 7-1G cm

Morphological Cosmianthemum Cosmianthemum Cosmianthemum Cosmianthemum B Edit Attributes X
lcharacters melinhense guangxiense knoxiifolium viriduliflorum caption TABLE 1. Comparison of Cosmianthemum ... morphologically alle. ..
| ID-Table-UUID: F5F42BCDFFSDFFSAF 1A78589FADFAES7
Habit herbs 0.3-0.6 m tall herbs up to 70 cm tall shrub, 60 cm tall herbs, up ta 60 cm tall [X/| httpUri: http://table.plazi.org/id/FSF42BCDFFIDFFIAF 1A78589FADFAES
’ X | startId: 6.[136,229,158,184]
X | targetBox: [144,1432,212,2061
2 subterete, pubescent when 4-angled to subterete, sulcate, = b L !
Stem 1ab ) b terete, puberulent terete, glabrous X | targetIsTable: true
‘ young soon glabrous sparsely pubescent X| targetPageld: 6
Leaf size 12-16< 4-6 cm 2-13.5x 1.4-4 cm §-20%1.8-7.3cm 7-15%4-9 cm
‘ Attribute Name « |Add /Set Attribute|
— ovate-elliptic to oblong- elliptic-lanceolate ta Attribute Value v
Leaf shape elliptic to ovate, lanceolate = = = ovate to broadly ovate
= = lanceolate lanceolate : Previous || [ OK Cancel ]
Petiole length 12-15 mm. pubescent 5—10-mm. pilose 6-32 mm. glabrous 10-25 mm. pubescent
; - adaxially pilose toward base | |adaxially glabrous. abaxially
adaxially glabrous, abaxially i ) e = ' X
Leaf surface == 2 | |oralong veins. abaxially puberulent along veins and both surfaces glabrous
pubescent along the veins - d = = = =
i & glabrous margin
’ . , : . . I table |
Lateral leaf veins 7=10 pairs 5-7 pairs 8=10 pairs 5-7 pairs 33 = r— 3
| bl |
compound dichasia in bleC:
I_X = : thyrses terminal. 3—10 cm thyrses terminal. thyrsoid. thyrses terminal 4-10 cm [ L= ol I
Inflorescence terminal or axillary. axis z = E
long interrupted. 20-60 cm long long | tableRow |




> WordFflow

e Fixing wordflow

Check the ‘word’ box (mandatory). Cut the stream when
needed and make the correct links.

You can use two combination of fFunctions:
- “Cut Stream Before” + “Click Predecessor”
- “Cut Stream After” + “Click Successor”




> WordFflow
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> Set Word Relation

e Setword relation between two words

Click in one of them and choose “Set Next Word
Relation” or “Set Previous Word Relation” and select the
appropriate option

P.S:

- Hyphenated word: syllables of the same word on
different lines

- Line-broken word: compound words separated by
hyphen, with each word on a different line




> Set Word Relation

[The Me Linh Station for Biodiversity was established in 1999 unde
Vietnam Academy of Science and Technology to facilitate the L
Province of the northeastern region of the country (Fig. 1). The stz
flora It is home to numerous Vietnamese endemics and has rece
several new species were discovered (Kim ¢f al. 2015 Hai et al: 2 ot  purple spot at base. slightly cury
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diver.si en 1985 Hu er al. 2011, Mapber pube; kamp 1960. Hansen 1985, Scotl:
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Icorollz surple spot at base. slightly curve 2006_:cular studies implied that it belo:
2 inse__zlabrous anthers with thecae par '

e e e i T e T e et i

The genus Cosmianthemum Bremekamp ( 1960 66) compris
diversity center in Borneo (Hansen 1985. Hu e al. 201 1. Mabb:
terminal. thyrsoid inflorescence; glandular-pubescent calyx. with

a xxith ate laswar lin hasnn

| ———— ,ubtribe Odontoneminae (Deng e
pubesc A amp 1960. Hansen 1985. Scotlan - : :
Ti Set Next Word Relation 2 = = stam Set Previous Word Relation > ® Separate Word la'
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StAmern  Show XML View of subSection
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> Set Word Relation

mm long, 5-lobed; lobes linear-lanceolate. ca 4 x 0.5-0.8 mm, subequal. apex acuminate. outside sparsely gland-ll 5 @;
tipped pubescent inside densely gland-tipped pubescent Corolla green-purple. 1.4-1.5 cm long outside gland-tipped o Annotation Attibutes .. : O [ seoto
pubescent; tube basally cylindric and 1.5-2 mm wide for 4.5-5 mm long: limb strongly 2-lipped. lower lip violeJ E::if:::t::t::::"bm o ] e
dotted. 5-5.5 mm broad, 3-lobed. middle lobes bigger than laterals. middle ovate. ca 2.5 mm long. laterals oblong 1= syt treatment Before [0 | journaic
1.5 x 2 mm:; upper lip violet blotched. triangular, ca 6 x 6 mm, 2-cleft Stamens 2. exserted: filaments ca 6 mm long [ SplitsubstbSection Before 1 O [ ke
glabrous: anthers bithecous. thecae oblong ca 2.5 mm long. superposed. muticous at base: staminodes 2. linear. 2—2.4‘_ ateE
mm long, glabrous. Ovary glabrous, green, fusiform with nectary flower disc bowl-shaped at base: style 910 mm . o R TE—— m [—"”;
long, glabrous. stigma slightly 2-lobed. Capsule clavate. 2.5-2.8 cm long. sterile portion 1.2—1.6 cm long. puberulent  set previous word Relation Separate Word with Pararaph Break After E
Seeds 4. ca. 3.5 x 5 mm. ovate, scarcely compressed. pale brown, rugulose-alveolate | Click Successor First Part of Hyphenated Word i
| |Etymology:—The species is named after the type locality, Me Linh Station for Biodiversity in Vinh Phuc Province.  spow s view... JiietRarcof finesBroken Wotd i
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the 1293 species present in tree inventories. Our work has led to the recognition of certain tdxo
nomic and nomenclatural novelties. including a new combination in Lecythis Loefl. (Lecythidaceae |

Set Next Word Relation )

Set Previous Word Relation > Separate Word

Click Successor Separate Word with Pararaph Break Before
Copy Text ® Second Part of Hyphenated Word

Show XML View of sibSection ‘ Second Part of Line-Broken Word
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> Select regions or word strings

e There are two ways to select regions or word strings

- Click near a word (but outside it) and drag your cursor
around the word string to select it (region)

- Click in a word and drag your cursor over the words until
the end of the word string to select it (word string)

This is useful in several ways, like make new annotations,
and/or merge paragraphs, as you will see in this course




> Select regions or word strings

Selecting region

Taxonomic treatment

Cosmianthemum melinhense D.V.Hai, ZLLin & Y.EDeng sp. nov.(Figs.2-4)

Type:—VIETNAM! Vinh Phuc Province; Phuc Yen Town: Ngoc Thanh commune. elev. ca: 152 m. 21
October 2016, Do Van Hai. Trinh Xuan Thanh: DVH 149 (holotype HN! isotypes HN. IBSC').

Selecting word string
Taxonomic treatment
Cosmianthemum melinhense D.V.Hai, ZLLin & Y FDeng. sp. nov. (Figs. 2-4)

Type:—VIETNAM. Vinh Phuc Province: Phuc Yen Town: Ngoc Thanh commune. elev. ca. 152 m. 2

https://tb.plazi.org/GgServer/summary/D51BB22BFFOBFFOCF12F8517FEGOAE2F



https://tb.plazi.org/GgServer/summary/D51BB22BFF9BFF9CF12F8517FE69AE2F

> Merge/split regions
e Merge paragraphs/blocks

Select the regions (or just a part of them) and choose
“Merge ‘paragraph’ Regions” and/or “Merge Blocks”

e Split paragraphs/blocks

Select just the region you want to split from the rest and
click on “Split ‘paragraph’ Region” or “Split Block”




> Merge/split regions

[Taxonomic treatment|

|Cosmianthemum melinhense D.V.Hai, Z1L.Lin & Y.FDeng, sp. nov. (Figs. 2—4)

Type:—VIETNA Aiatk Becran >ic Yen Town. Ngoc Thanh commune. elev. ca. 152 m. 21°2351.3"N. 105°4256.8'E. 2]
[October 201 %vmm DVH 149 (holotype HNE isotypes HN. IBSCJ!
Revise Block Paragraphs ‘

Taxonomic treatment|

Cosmianthemum melinhense D.V.Hai, ZLLin & YEDeng sp. nov. (Figs.2-4) Mok Regain d

Remove Region ...

v

Type:—VIETNAM. Vinh Phuc Province: Phuc Yen Town Ngoc Thanh commune, elev. ca. 15 Revise Block Paragraphs | 42'56.8E. 21
October 2016, Do Van Hai. Trinh Xuan Thanh. DVH 149 (holotype HN! isotypes HNL IB Split Block
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> Merge/split annotations

e Merge annotations

Select parts of the annotations and choose to merge
them. For example, “Merge materialsCitations”

e Split annotations

Decide where the desired boundary will be, click on the
First word of the desired second annotation and choose to
split them before. For example, “Split materialsCitation
Before”




> Merge/split regions

\Cosmianthemum melinhense D.V Hai, Z1.Lin & Y EDeng. sp. nov. (Figs. 2-4)|

|Type:—VIETNAM. Vinh Phuc Province: Phue Yen Town Ngoc Thanh commune. eley. ca. 152 m. 21723 _
[October 2016, Do Van Hai, Trinh Xuan Thanh. DVH 149 (holotype HN ! isotypes HN' IBSC} ‘

i Find Next '51.3 ... 2016' \

|Type:—[VIETNAM. Vinh Phuc Province: Phuc Yen Town. Ngoc Thanh commune. elev. ca. 152 m. 21°2351.3"N, 105°4256.87E. 21
October 2016, Do Van Hai. Trinht Xuan Thanh. DVH 149 (holotype HN ' isotypes HNU TRSCH

Edit Annotation Attributes ... >

Copy Annotation Attributes ... >

Remove Annotation ... >

” » r v » I -
[ANEWSPECIES ORCOSMIANTHEMUM{MELINAENSE—————Phyio i s vestment o JliaProsy # 123
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> Extend boundaries

e Extend annotation boundaries

Select a part of the annotation and drag the cursor until
the desired new boundary, then select to extend it. For
example, “Extend bibRef”
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> Extend boundaries

= SR SRS,

e ——

Vietnam Annales Botanict Fennici 55 (4—6) 333-337

[Hai, DV, Oanh. P.T. Deng. Y.F. Lin, ZL. Choudhary RK. & Lee. J K. (2018} Rungia khoir i Acanthaceae), a new species from northem‘

(https //doi ore/10.5735/085.055.04 17|

195-197.

|Hansen, B. (1985} Cosmianthemum knoxiifolium (C. B Clark

. Hansen comb. nov. (Acanthaceact Nordic Journal of Botany S

i x

|Hai, DV Oanh, P.T, Deng, Y F. Lin, ZL. Choudhary RK. &
Vietnam Annales Botanicl Fennict 35 (1—6) 333-337 1
[htips /doi ore/ 10.5735/085.055.0417)

Extend bibRef

|Hansen, B. (1985 Cosmianthemum knoxiifolivm (C. B Cla

195-197.

L T e S
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I Acanthaceae). a new species from northern

«canthaceact Nordic Journal of Botany S
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> Set text stream type

e Selectthe string, click on “Set Text Stream Type” and
choose the correct one. The main types are:

- mainText: all the main parts of the document, as head,
abstract, introduction, materials, results, discussion...

- pageTitle: page headers and/or footers, containing
journal name, volume, year, publisher, page number...

- Footnote: page footers containing information about
something in the main text

- caption: caption of tables or images

- label: text inside images or graphics

- table: text inside tables




> Set text stream type

TGURTYIEMa  showing therfy paocaliny biHC oy IR

Mark In-Line Caption

Mark Footnote
‘ Mark Table Note
|Taxonomic treatment|  Mark Parenthesis |
L e
|_Cosmianthemum melinhense DN Hai, ZL., st Next Word Relation i/ ® caption
Set Previous Word Relation 1 deleted
= = , Cut Stream Before footnote =
Type:—{VIETNAM Vinh Phuc Province: Phuc Ye
o : . ] Cut Stream After label
October 2016, Do Van Hai. Trinh Xuar Thanl ek Peltersn Tt |
Click Successor pageTitle
Make Stream table L
Set Text Stream Type i tableNote \__,

CQet Tevt Nirertinn )




> Mark captions and other annotations

e Mark captions

If they are not already marked, select the entire region for
the caption and click on “Mark Caption”

- For page headers or footers -> Select “Mark Page Header”
- For footnotes -> Select “Mark Footnote”

- For tables -> Select “Mark Table”

- For table notes -> Select “Mark Table Note”

P.S: This tool adds the annotation but also fix text stream
types automatically




> Mark captions and other annotations

[FIGURE 1. Map showing the type locality of Cosmianthmemum melinhensé

ITaxonomic treatment|

Mark Region
Remove Region ...
Split Block

Mark Table
Mark In-Line Table

v
1
=

> Mark In-Line Caption
Mark Footnote
Mark Table Note

\Cosmianthemum melinhense D.N Hai, ZLLin & Y F Dengl sp. zz(f_ «

1132« Phytotaxa 538 (2) © 2022 Magnolia Press

HAI ET AL]

=»
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Split Block

Mark Table
Mark In-Line Table

Make Stream
Set Text Stream Type >

Copy Text
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> New Annotation

e To create a new annotation, simply select the whole text
that you want to annotate and click on ‘Annotate’

If the annotation already exists and is checked in the

display control you can just select it in the list that
appears

If not, select ‘Annotate’ again and manually add the new
annotation (check if the spelling of the word is correct)




> New Annotation
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& HS Lo) HS Ldlii

Annotate
Edit Annotation Attributes ...

1‘
Remove Annotation ... {
List 'Vulnerable (VU)' ... ‘

Mark Table Note

Set Text Stream Type >
Copy Text

Show XML View ...

More ..

Annotate ..
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> Annotation attributes

e You can always ‘Edit Annotation Attributes'
Select the type of annotation you want to edit. Only
those that are toggled on in the display control will be
available to edit

e Option to copy attributes

You can copy the attributes from an annotation of the
same type and edit it afterwards




> Annotation attributes
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|| family: Acanthaceae
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kingdom: Plantae
order: Lamiales
phylum: Traéheophyta
rank: species

species: melinhense
status: sp. nov.
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> Annotation boundaries

e Make sure the boundaries are correctly delimited
Expand, split or merge annotations
Always check if paragraphs are correct

Attributes may also be erroneously assigned depending
on the way the boundaries were set




> Annotation boundaries
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> Remove annotations

e Select ‘Edit -> Remove Annotations’ and choose which
one you want to remove from the document

It will remove all the annotations of that type presentin
the document
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> Naming documents

e Use abbreviated names of journals, followed by volume,
issue and pagination.

It depends on each journal

FarEastEntomol 402.1-36.pdf

RafflesBZ00l.68.369-378.pdf
PapAvZool.60.e20206039.pdf

PersJourAcarology.9.1.67-81 pdf

Candoliea.75.2.241-244 pdfi

TheColeopBull.74.4.367-646.pdf

ActaZoolAcadSciH.66.1.23-33.pdf
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> Saving a file

e “File” -> “Save Document As” to save as IMF File
e “File” -> “Save Document to GoldenGATE server” to save
straight to Plazi server
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